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1 Overview

1.1 Introduction

Your StudioLive™ AR USB-series mixer comes with a powerful recording software 
library that includes both Capture™ and Studio One® Artist. Designed exclusively 
for StudioLive™ mixers, Capture™ multitrack recording software allows instant 
setup and one-click recording at up to 96 kHz directly from the mixer, with 
no configuration. Studio One Artist provides as fast, flow-oriented, drag-and-
drop interface built by creative people for creative music production. 

We encourage you to contact us with questions or comments regarding 
this product. PreSonus Audio Electronics is committed to constant 
product improvement, and we value your suggestions highly. We believe 
the best way to achieve our goal of constant product improvement is by 
listening to the real experts: our valued customers. We appreciate the 
support you have shown us through the purchase of this product.

1.2 About This Manual

We suggest that you use this manual to familiarize yourself with the features 
and correct connection procedures for your StudioLive AR USB mixer 
Software Library before trying to connect your  Live mixer to your computer. 
This will help you avoid problems during installation and setup.

Throughout this manual you will find Power User Tips. These tips provide 
useful hints on how to best use the StudioLive AI Software Library and 
take advantage of unique workflow functions and features.
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1.3 Technical Support

Many technical issues can arise when using a standard computer as a digital 
audio workstation (DAW). PreSonus can only provide support for issues that 
directly relate to the StudioLive AR USB mixer, Capture, and Studio One.

PreSonus does not provide support for computer hardware, iOS hardware, wireless 
networks, operating systems, and non-PreSonus hardware and software, and it may 
be necessary to contact the manufacturer of these products for technical support.

Please check our Web site (www.presonus.com) regularly for 
software information and updates, firmware updates, and 
support documentation for frequently asked questions.

Online technical support is available at www.presonus.
com/support/Contact-Technical-Support.

Advanced troubleshooting guides can be found at support.presonus.com/forums.

1.4 Summary StudioLive AI Software Library Features

1.4.1 Capture 

Included with StudioLive is Capture, a digital-audio multitrack-recording application 
designed to make recording quick and easy. Perfect for live recording and for mixing 
your audio in real time to a stereo audio file, Capture was designed to interface 
perfectly with StudioLive-series mixers, allowing instant setup and recording.

Capture allows you to record a single stereo track from the StudioLive’s main output, 
one pair of subgroup outputs, or a pair of aux sends, in addition to all input channels. 
This enables you to record the main mix or create a separate recording mix.

 • Multitrack recording application (unlimited input 
channels plus stereo stream from StudioLive)

 • One-click recording with Record Now button

 • Prerecord captures audio up to a minute before you press Record

 • Auto-Save at user-definable intervals

 • Automatic session and file recovery if the power fails

 • Sessions store metadata, enabling automatic session naming

 • Session Lock feature prevents accidental keyboard access

 • Essential editing suite (copy, cut, paste, splice, resize)

 • Big Meter mode turns your monitor into a gigantic meter bridge

 • Stereo Playback mode—use Capture with any computer sound card

 • Peak LED-style meter bridge with clip indicators

 • Marker placement and recall

 • Marker List with Quick Locate

 • Export between markers

 • Record stereo mix from StudioLive AR USB mixer

 • Full transport control

 • Import/export individual WAV, AIFF, or OpenTL

 • Compatible with Mac® and Windows®
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1.4.2 Studio One Artist

All PreSonus audio interfaces include PreSonus Studio One Artist recording 
software, which comes with over 6 GB of plug-ins, loops, and samples, giving 
you everything you need for music recording and production. The Studio 
One Artist Quick Start Guide is located in Section 4 of this manual. You will 
find a complete user manual on the Studio One Artist installation DVD.

 • Unlimited track count, inserts, sends, and plug-in instantiations

 • 20 high-quality PreSonus Native Effects™ plug-ins, in eight categories: 
amp modeling (Ampire XT), delay (Analog Delay, Beat Delay), distortion 
(RedLight Dist™), dynamics processing (Channel Strip, Compressor, Gate, 
Expander, Limiter, Tricomp™), equalizer (Channel Strip, Pro EQ), modulation 
(Autofilter, Chorus, Flange, Phaser, X-Trem), reverb (Mixverb™, Room Reverb), 
and utility (Binaural Pan, Mixtool, Phase Meter, Spectrum Meter, Tuner)

 • Four high-quality PreSonus virtual instruments, including: Presence™ 
sample player, Impact™ drum machine, SampleOne™ sampler, 
and Mojito analog-modeled subtractive synthesizer

 • Over 6 GB of loops, samples, and instruments

 • Open Capture 2 files natively

 • Innovative and intuitive MIDI mapping

 • Powerful drag-and-drop functionality for faster workflow

 • Mac OS X® and Windows® compatible
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2 Connecting to a Computer

Connecting your StudioLive AR USB mixer to your computer is quick and 
easy. For Mac users, just connect your mixer to a free USB connection on your 
computer and you’re ready to go. For Windows users, you must first install 
Universal Control AI. This will install both the ASIO/WDM driver and the control 
panel for your StudioLive AR USB-series mixers. We made this installer as 
simple and easy to follow as possible, and it will take you through each step 
of the installation process. Please read each message carefully to ensure the 
StudioLive driver and the control panel are properly installed. In particular, be 
careful not to connect your StudioLive mixer to the computer too soon.

Please visit www.presonus.com for the latest system requirements 
and an updated list of compatible hardware. It is also recommend 
that you check your recording software’s system requirements.

Power User Tip: The speed of your processor, amount of RAM, and 
capacity, size, and speed of your hard drives will greatly affect the overall 
performance of your recording system. A faster processor and more RAM 
can reduce signal latency (delay) and improve overall performance.

2.1 Installation for Windows

Before beginning the installation setup, please quit all applications, including 
antivirus software, and disconnect the StudioLive mixer from your computer.

Follow the onscreen instructions to complete the installation. When the 
installer has finished, it will prompt you to reboot your computer. 
 
 
 
 
 
 

Click “Finish” to automatically restart your PC. Once your computer has 
rebooted, connect the StudioLive. When the Found New Hardware 
wizard launches, follow the “Recommended” steps. 
 
 
 
 
 

Your StudioLive is now synced to your computer and ready to use!
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2.1.1 Universal Control AI (Windows only)

Sample Rate. Changes the sample rate.

You can set the sample rate to 44.1, 48, 88.2, or 96 kHz. A higher sample 
rate will increase the fidelity of the recording but will increase the file size 
and the amount of system resources necessary to process the audio.

At 44.1 and 48 kHz, all DSP functions are available. At 88.2, 96, 
176.4, and 96 kHz, Fat Channel processing will be available on 
analog inputs only and the delay bus will be disabled.

Safe Mode. Adjusts the Input Buffer Size.

These modes allow you to adjust the input buffer size 
to optimize performance for your computer. 

When adjusting the safe mode, the block size will be adjusted 
automatically to provide the best performance.

Block Size. Sets the buffer size.

From this menu, you can set the buffer size from 16 to 4,096 samples (Mac), or 64 
to 8192 samples (Windows). Lowering the buffer size will lower latency; however, 
this will also increase performance demands on your computer. In general, you will 
want to set the buffer size as low as your system can safely support. If you begin 
to hear pops, clicks, or distortion in your audio path, try raising the buffer size.

Note: When adjusting the block size, the Safe Mode will 
automatically change to provide the best performance.

2.1.2 Loopback Recording (Windows only)

The windows drivers for the StudioLive AR-series mixers provide two virtual 
streams that allow you to record the output of on audio application in 
another application. Loopback can be useful in a variety of situations:

 • Recording the audio from a video game or YouTube 
video for a podcast or livestream.

 • Recording a vocal in real time over a karaoke track 
played from a web browser or media player.

Power User Tip: Because the StudioLive AR-series mixers are class compliant Core 
Audio devices, these virtual streams are not available in OS X. However, there 
are several third-party applications that provide this functionality in OS X.
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From Universal Control AI, you can enable or disable Loopback and 
pick the streams on which the looback audio will be recorded.  

When Loopback is enabled and “Merge Loopback with 1/2”  is selected, 
the audio from another application will be recorded with the audio source 
connected to analog inputs 1 and 2 on your StudioLive AR mixer.

Media Player
Web Browser
Etc.

When Loopback is enabled and “Dedicated Loopback Inputs” is 
selected, the audio from another application will be recorded on the 
last pair of driver inputs (AR8: 9/10, AR12: 15/16, AR16: 19/20).

Media Player
Web Browser
Etc.

Power User Tip: When using either option, you will need to select Outputs 1 and 
2 in the audio application your want to record. Make sure to select Outputs 3 and 
4 in the audio application in which your recording to avoid a feedback loop.



7

2 Connecting to a Computer 
2.2 Installation for Mac OS X

StudioLive™ AR-Series Software  
Library Reference Manual

2.2 Installation for Mac OS X

The StudioLive AR USB mixers are class compliant audio devices in OS X. No 
installation is required. Just connect your mixer to a free USB connection 

2.2.1 Using the StudioLive for System Sound

You can configure your StudioLive AR-series mixer as the 
audio interface for computer system audio (for iTune playback, 
Skype, etc.) from the System Preferences menu.

1. Open System Preferences 

2. Open your System Sound Preferences 
 
 
 
 
 
 

3. Select your StudioLive AR-series mixer from the Outputs 
list. If you would like to use your StudioLive mixer for 
System input, select it from the inputs tab as well.



8

2 Connecting to a Computer 
2.3 Using the StudioLive with Popular Audio Applications

StudioLive™ AR-Series Software  
Library Reference Manual

2.3 Using the StudioLive with Popular Audio Applications

Below are basic driver-setup instructions for several popular audio 
applications. Complete setup instructions for PreSonus Studio One Artist 
and a brief tutorial on its features are located in Section 7 of this manual.

Steinberg Cubase 4+

1. Launch Cubase.

2. Go to Devices | Device Setup.

3. Select “VST Audio System” from the Devices column in the Device Setup.

4. Select PreSonus FireStudio from the ASIO Driver dropdown list.

5. Click “Switch” to begin using the StudioLive Driver.

6. Once you have successfully changed the driver, go to Devices | 
VST Connections to enable your input and output buses.

Ableton Live 5+

1. Launch Ableton Live.

2. Go to Options | Preferences | Audio.

3. Choose Driver Type: ASIO | Audio Device: ASIO PreSonus StudioLive AR

4. Go to Input Config : Enable and select the desired Input channels.

5. Go to Output Config : Enable and select the desired Output channels.

6. You may now select the StudioLive’s inputs and 
outputs for each track created in Live.

Apple Logic Pro/Express 7+:

1. Launch Logic Pro/Express.

2. Go to Logic | Preferences | Audio.

3. Click on the Devices Tab.

4. On the Core Audio tab, check Enabled.

5. Select PreSonus StudioLive AR from the device menu.

6. You will be asked if you’d like to relaunch Logic. Click “try (re)launch.”

7. Your StudioLive features custom I/O labels for faster work flow. To enable 
these labels for use in Logic, go to Options | Audio | I/O Labels.

8. The second column in the pop-up window will be named 
“Provided by Driver.” Activate each of these labels for your 
StudioLive. When you are done, close this window.

9. You are now ready to use your StudioLive.
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Avid Pro Tools 9+

1. Launch Pro Tools.

2. Got to Setup | Hardware and select PreSonus StudioLive 
AR from the Peripherals list. Click OK.

3. Go to Setup | Playback Engine and select PreSonus FireStudio 
from the menu at the top of the window. Click OK.

Cakewalk Sonar 6+

1. Launch Sonar.

2. Go to Options | Audio... and click on the Advanced tab.

3. Change the Driver Mode to “ASIO.”

4. Click the “OK” button.

5. Restart Sonar.

6. Go to Options | Audio... and click on the Drivers tab.

7. Highlight all input and output drivers beginning with “PreSonus StudioLive AR.”

8. Go to Options | Audio... and click on the General tab.

9. Set the Playback Timing Master to “PreSonus StudioLive AR ... DAW Out 1.”

10. Set the Recording Timing Master to “PreSonus StudioLive AR ... Mic/Inst 1.”

2.4 Digital Sends and Returns

When using the StudioLive as an audio interface, it is important to 
understand the terms “digital send” and “digital return.” Because the 
audio interface in the StudioLive is completely integrated with the other 
functions of the mixer, the USB I/O is designed to work as an independent 
bus. You can route (send) signals from other buses to the USB bus, and its 
output (return) signal is hard-coded to designated mixer channels.

The StudioLive AR8 USB has 8 available sends and 4 returns.

The StudioLive AR12 USB has 14 available sends and 4 returns.

The StudioLive AR16 USB has 18 available sends and 4 returns.

2.4.1  Digital Sends

Each Mono and Stereo channel on the StudioLive AR-series mixer has its own digital 
send. This allows you to record every channel input on its own track in Capture, 
Studio One Artist, or your favorite Core Audio and ASIO audio application. 

The Main bus also features its own digital send on the final pair 
of digital sends (AR8: 7/8, AR12: 11/12, and AR16: 15/16). 

Note: In Windows, these sends are the second to the last pair. The last pair of driver 
inputs are reserved for loopback functionality. See Section 2.5 for more information.

The Main bus can also be recorded on the first two digital sends by engaging the USB 
send 1/2 button on your StudioLive AR-series mixer. When this button is engaged, 
Channels 1 and 2 cannot be recorded independently, but they will be recorded as 
part of the Main Mix. This is a great option for recording rehearsals and podcasts.
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2.4.2 Digital Returns

The last two stereo channels on the StudioLive AR mixers are hard-coded 
to receive two stereo digital returns. Digital returns 1/2 are available on 
the Super Channel, Digital returns 3/4 are routed to the last stereo 
channel (AR8: 6/7, AR12: 11/12, AR16: 15/16). Outputs 1 through 4 in your 
recording application route these playback streams to these channels on 
the StudioLive (that is, the software’s Outputs 1/2 always go to StudioLive 
AR Super Channel and Output 3/5 always go to the last stereo channel). 
Once you route a track in your recording application to play through one 
of these outputs, it will always be accessible on its channel by simply 
pressing the Digital Return button.

Power User Tip: It is important to think of your digital returns and your analog inputs in 
the same way. When a digital return is engaged, it replaces the analog input in the mix. 
You can process it in the Fat Channel, include in it Aux mixes, and send it to an FX mix.
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3 Capture 2

PreSonus® Capture™ 2.0 is a multitrack digital-audio recording application designed 
to make recording with StudioLive™ mixers quick and easy. With the look and feel of 
a digital multitrack hard-disk recorder, it is instantly familiar. It uses the same high-
quality audio engine as PreSonus’ groundbreaking Studio One® DAW, and its Session 
files can be opened directly in Studio One—no conversion or exporting required.

Capture 2 was designed exclusively for StudioLive-series mixers, 
allowing instant setup and recording directly from the mixer, with 
no configuration. Just launch Capture 2 and click Record Now. At 
the end of the show, click Stop, save the file, and you’re done!

3.1 Installation Instructions

3.1.1 Mac OS X

Installing Capture 2 on Mac OS X machines is as simple as drag-and-drop.

1. Double-click on the Capture .dmg file. 
 
 
 
 
 
 

2. Drag the Capture 2 icon to the Applications folder shortcut. 
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3. Once Capture has been copied to your hard drive, it is ready to use. Simply 
open your Application folder and double-click on the Capture 2 icon. 
 
 
 
 

3.1.2 Windows

The Windows installer for Capture 2 was designed with easy-to-follow 
onscreen instructions to make the installation process quick and simple.

1. When you launch the Capture.exe file, a Welcome Screen will launch. If you haven’t 
already done so, close all other open applications before clicking “Next.” 
 
 
 
 

2. Before Capture 2 can be installed on your computer, you must first agree to the 
licensing terms. Click “I agree.” 
 
 
 
 

3. By default, Capture 2 will install in the Program Files folder on your computer. It is 
highly recommended that you do not change this default location. Click “Install.” 
 
 
 
 

4. Once Capture 2 has been successfully installed on your computer, you can click 
“Finish” to exit the install wizard. You’re ready to start recording! 
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3.2 Start Page

You will be taken to the Start page when Capture 2 is launched. The Start page allows 
you to create a new Session, open a Session stored on your computer, view recent 
Sessions, and verify that your StudioLive is properly communicating with its driver. In 
addition, you can begin recording instantly by just clicking the Record Now button.

3.2.1 Tagging and Organizing a Session

At the top of the Start page, you will find the three Name Scheme 
fields: Artist, Performance, and Location. By entering information into 
each of these fields, your Session will be automatically named with this 
information, in this order, and tagged with the same helpful metadata.

These tags also help to keep your files organized. Rather than throwing 
every Session into a single folder, all tagged Sessions will automatically 
be put into an organized folder hierarchy. By default, Capture 2 inserts 
the date of performance and creates subfolders. These options can 
be changed in the Options menu, see Section 6.2.5 for details.

By default, the folder tree is Artist/Performance/Location. This structure 
is useful for regularly gigging bands that want to archive performances 
(e.g., Artist: PreSonus All Stars, Performance: Winter Tour 2013, Location: 
Baton Rouge – Manship Theatre). However, Capture 2 doesn’t limit you to 
this folder structure. You can change the folder hierarchy from the Options 
menu. Here are other available Name Schemes: 
 
 

 • Location/Artist/Performance. This Name Scheme is especially useful 
for venue owners who are archiving the performances on their stage 
(e.g., Location: Manship Theatre/PreSonus All Stars/Winter Tour 2013.

 • Location/Performance/Artist. Use this Name Scheme when recording 
an entire festival (e.g., PreSonuSphere/Stage 1/PreSonus All Stars).

As you archive your performances, Capture 2 stores a history of the names you have 
entered into each field. To use a name again, simply click on the pull-down menu for 
that field and select it from the list. 
 
 

To clear the currently selected name from the list, select Remove First from the 
pull-down menu. 
 
 
 

To remove every name in the list, select Clear History. Once the history has been 
cleared, it cannot be undone, so be certain before you choose this option. 
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3.2.2 Creating a Session

Below the Name Scheme fields, you will find the New Session button. Click on the 
New Session button to create an empty Session.

Power User Tip: A Session is a Capture 2 file in which you record, arrange, 
and edit your audio files. Session files should not be confused with audio 
files. Think of a Capture 2 Session as you would a StudioLive scene. It is a 
snapshot of which audio files were recorded and how they were edited.

You can also create a new Session by doing one of the following:

 • Navigate to File/New Session. 
 
 
 
 
 
 
 

 • Press [Ctrl]/[Cmd]+N on the keyboard.

If you have filled in the Name Scheme fields, your 
new Session will launch automatically.

If you have not filled in these fields, a setup menu will open.

 • Session Title. This will be the title of your Session and will be the Session filename, 
as well as the name of the new folder that contains all data related to your Session.

 • Session Folder. This is where new Sessions and all related data will be saved. 
The Session location can be chosen each time you create a Session. By default, 
the new Session location will be the Capture 2 folder in your Documents folder.

You can choose a different file location by clicking on the Browse button and 
browsing to a new location. The last known save location will appear as the default 
the next time you create a new Session.

Power User Tip: The Name Scheme fields have been added to Capture 2 
to help keep your Sessions organized and to make your archived library 
of live performances more easily searchable. Because of this, we highly 
recommend that you always take a moment to fill in these fields.
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Record Now! Clicking the Record Now button on the Start page will launch a new 
Session, arm all tracks for recording, and begin recording immediately. If you do not 
have any of the Name Scheme fields customized, your Session will be labeled with 
today’s date. 

3.2.3 Open a Session

The Capture 2 Start page provides two different 
ways to quickly open previous Sessions. 

Open Session Button

Clicking on the Open Session button will open a browser that will allow you to 
browse for, and open, an existing Session. 
 

Recent Files List

Located below the Open Session button, you will find the Recent 
Files list. This list includes links to the most recently opened 
documents. Click on any of these links to quickly open the 
Session. 
 
 
 
 

Locate Missing Files

In the event that the Session you open is missing audio files, Capture 
will help you find them. Use Session>Locate Missing Files to search your 
computer for lost resources. 
 
 
 
 
 
 
 
 

3.2.4 Audio Device and Sample Rate

Capture 2 was created for use with PreSonus StudioLive-series mixers and 
fully functions only with that device. The Audio Device menu displays the 
currently selected audio driver. When a StudioLive AR Mixer is connected, you 
should select “PreSonus StudioLive AR16/12/8” from the Audio Device list.

If the currently selected audio device has exactly two outputs (as with the built-
in audio card in a Mac), Capture goes into Stereo mode. While in Stereo mode, 
Capture connects all tracks to the stereo output and adjusts the volume of the 
output automatically to account for stereo summing. Stereo mode enables you 
to listen to Sessions while away from your StudioLive. Unless the StudioLive’s 
driver is selected, you cannot create a new Session or record new audio.

The Sample Rate menu displays the currently configured sample rate.
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3.2.5 Options Menu

The Options button can be found just above the bottom of the Start page. This 
launches the Options menu. 
 
 

This menu can also be accessed from Capture>Options. 
 
 
 
 
 
 
 

It can also be accessed by clicking on the Options button on the Session page.

The Options menu provides all the tools necessary 
to configure your Session preferences.

Audio Options

 • Audio Device. At the top of the Audio Options, you will find 
the Audio Device menu. This is the same menu that is on 
the Start page. See Section 3.2.4 for information.

 • Device Block Size. This displays the buffer size. In general, the higher the 
buffer size is set, the more stable your recording environment will be.

 • Sample Rate. The Sample Rate menu is also found on the 
Start page. See Section 3.2.4 for information.

 • Record Format. The Record Format menu allows you to 
choose the bit-depth of the recorded audio. You can select 16-
bit WAV, 24-bit WAV, or 32-bit floating-point WAV. 

Power User Tip: The higher the bit-depth of your audio, the better its resolution, and 
the bigger the resulting file size will be. In general, we recommend recording at 24-bit.

 • Pre-Record. Capture 2 allows you to set a Pre-Record buffer. This 
buffer starts recording audio before your click the Record button so 
you won’t miss the beginning of a performance. The Pre-Record buffer 
time is user-selectable, between five seconds and one minute.

Power User Tip: The higher the Pre-Record buffer is set, the more RAM Capture 2 will 
require. While this will not cause problems on modern systems that are equipped with 
copious amounts of RAM, it is highly recommended that the Pre-Record buffer be set 
as low as possible on systems with the minimum amount of required RAM (2 GB).
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Timeline Sync Options

 • Timeline Sync Mode. Capture 2 features a Timeline Sync mode. This 
allows you to align the timeline in your recording Session to the time of 
day or to sync it to an external MIDI Time Code signal. This will also affect 
the timestamp information, which is written into the audio files.

 • No sync. The timeline will start at 0 and will display the length of 
your recording (in minutes and seconds only). This option is useful 
when you only want to track the length of your recording.

 • Sync to computer time. The timeline ruler will start at the exact time of 
day the recording began. This option is useful when recording multiple 
performances over the course of a day (e.g., at a festival stage).

 • Sync to MTC. Capture will align the timeline to incoming MIDI Time 
Code. This option is useful when recording audio for a live video.

 • MIDI Time Code Input. To use the Sync to MTC option, you must provide Capture 
with an input for the source time code. You can select that source from this menu.

File Handling Options

As discussed in Section 3.2.1, Capture 2 provides an assortment 
of useful tools to organize and label Capture Sessions.

 • Storage Location. By default, all Capture Sessions are stored in the 
Capture subfolder in your Documents folder. You can set a new default 
location by clicking on the “Change…” link. This will launch a browser 
window, allowing you to find a new location for your Capture Sessions.

 • Name Scheme. Section 3.2.1 discusses the various options 
for naming and organizing your files. This option enables you 
to select the order in which your files are categorized.

 • Create Subfolders. Clicking the Create Subfolders options will 
create a folder for each of the three naming conventions: Artist, 
Performance, and Location. If this box is not checked, your Session 
and the resulting audio files will still be labeled using these tags but a 
folder hierarchy will not be created. This box is enabled by default.

 • Add Date to Path. By default, Capture automatically adds the date of the Session 
to the Session name. You can remove the date by unchecking this option.
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3.3 The Session Page

Capture 2 features a single-window user interface so you don’t need to 
manage multiple windows and views. When a new Session is created, or an 
existing Session is opened, you will be taken to the Session page. This page 
contains all of the necessary tools to record and edit multitrack audio.

When you launch Capture 2, a recording track is created for each input 
channel on your StudioLive AR mixer, including the Main bus. The Main 
bus track, in turn, is automatically patched to the first two digital returns 
located on the Super Channel on your StudioLive AR mixer for playback. 
Channels 1 and 2 are routed to the Digital Returns 3/4 on the last stereo 
channel. The following diagrams show these configurations.

Capture 2 Recording Routing

Capture 2 Playback Routing

There is no need to set up audio inputs and outputs in Capture 2, as the 
software automatically detects which StudioLive model is connected 
and auto-configures for it. Each channel from the StudioLive AR mixer 
is represented with a mono input track in the Track column of the 
Session and has a corresponding level meter in the meter bridge. 

An additional stereo track will also be added to the 
Session for recording the main mix.
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3.3.1 Track Column

Along the left side of the Session page, you will find the Track column. The Track 
column contains a dedicated audio track for each audio input into Capture 2 from the 
StudioLive AR mixer, plus a stereo audio track to record the main mix. 
 
 
 
 
 
 

Track Naming.

To name a track, double-click on the default name to open a text-
edit box. Enter the name you would like to use and hit Enter.

There are several benefits to giving each track in your Session a name. First, 
it allows you to know at a glance what is being recording where. Second, if 
you name your tracks before you begin recording, the audio file recorded 
on your named track will be given the same name. So, for example, instead 
of a bass line being recorded as Track 15, it would be recorded as Bass.

Power User Tip: As with UC Surface and Studio One, you can 
press the Tab key to move to the next track’s name field.

Arm All.

In the upper left-hand corner, you will find the Arm All button. Click this button to 
arm (enable) all inputs for recording.

Track Controls.

Each track in the Track column features the same controls.

Record Arm Button. Next to each track number is the Record Arm button. When 
this button is active, Capture 2 is ready to record audio that is routed to the track.

Power User Tip: The track number to the left of each track in the list corresponds 
directly to the same channel number on your StudioLive AI mixer.

Track Mute. Each track features a Mute button. This mutes the track during playback.

Track Solo. Each track features a Solo button. This will solo the track and mute 
all other tracks during playback (similar to the SIP function on the StudioLive).

3.3.2 Transport

The Transport is located in the top left corner of the 
Session page. It contains all the functions you need to 
navigate through your Session. 
 
 

Stop. Stops playback. 
 

Play. Starts playback at the current playback-cursor position. 
 

Record. Starts recording at the current playback-cursor position. 
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Session Lock. The Record Lock button prevents the recording from accidentally 
being stopped by an errant press of the space bar. Session Lock is automatically 
enabled when Capture starts recording. It can be defeated by simply clicking on it.

Power User Tip: Markers can still be edited and dropped while Session Lock is enabled. 

Return to Zero. Returns the playback cursor to the beginning of the Session. 

Previous Marker. Jumps the playback cursor to the previous marker. 

Rewind. Rewinds as long as this button is enabled. 

Fast Forward. Fast-forwards as long as this button is enabled. 

Next Marker. Jumps the playback cursor to the next marker. 

Go To End. Jumps the playback cursor to the end of the recorded audio. 

Loop. Engages/disengages Loop mode. See Section 3.3.6.6 for more information. 

3.3.3 Time Display

The Time Display provides you with critical information about your recording.

Session Name. Displays the name of the current Session.

Record Duration. Displays how long the current Session has been recording.

Cursor Time. Displays the current timeline position of the playback cursor.

Remaining Time. Displays the remaining time that can be recorded, based on the 
size of the available storage left on the hard drive to which you are recording.

3.3.4 Timeline Ruler

At the top of the Session Editor, you will find the Timeline 
Ruler. This displays time increments in seconds.

As mentioned in Section 3.2.5, you can set the Timeline Ruler to sync to 
your computer’s clock or to an external MIDI Time Code source.

3.3.5 Navigating the Session

Zooming

You can zoom in and out of your Session, with respect to time, in the Session 
Edit window, so that you can look at the entire length of the Session or 
just view a small region of time to make accurate edits. You can also zoom 
in and out with respect to the size of the audio files in your Session.

To zoom, do one of the following:

 • To zoom in or out, click-and-drag left or right on the Horizontal Zoom scroll bar in 
the lower right-hand corner of the Edit window.

 • Press [Ctrl]/[Cmd]+[+] on the keyboard to zoom in slightly. Press 
[Ctrl]/[Cmd]+[-] on the keyboard to zoom out slightly.
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 • Click inside the Timeline Ruler at any point in time 
and drag down or up to zoom in or out. 

 • In the lower left-hand corner of the Edit window, you will find the vertical-zoom 
controls. These controls increase or decrease the height of the tracks and 
audio files. 
 
 
 
 

Scrolling

To scroll left and right through time in your Session, click-and-drag 
the horizontal scroll bar near the bottom of the Edit window.

You can also scroll through your Session by clicking and 
dragging the Timeline Ruler left or right.

Locate Selection

To jump the playback cursor to the beginning of any audio event, 
press L on the keyboard or select Session>Locate Selection.

3.3.6 Editing Tools

In the upper right corner, you will see four editing-tool buttons. These 
tools will determine the function of your mouse during editing.

Power User Tip: The audio-editing process can be unforgiving. Small inaccuracies when 
splitting, moving, or performing other actions on recorded audio can lead to unwanted 
results. As simple as it may seem, the act of listening while editing is often overlooked. 
For instance, when sizing the edges of a vocal part to remove unwanted sounds 
between words, it is tempting to make the edits based on the visual representation of 
the waveform. While this may work sometimes, it is much better to listen as you size 
the events to be sure you are not removing any critical part of the vocals. Listening 
to your edits as you make them will save time and frustration in nearly every case.
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3.3.6.1 Arrow Tool

This is the default tool for access to most functions. Click on the Arrow tool button or 
press [number 1] on the keyboard to select the Arrow tool.

The Arrow tool can be used for the following purposes:

Move an Event.

To move an audio event using the Arrow tool, click anywhere on the event and 
drag left, right, up, or down. Dragging the event left or right will move the event 
backward or forward in time. When dragging an event left or right beyond the 
viewable arrangement, hold [Space Bar] on the keyboard to speed up the scrolling.

Dragging the event up or down will move the event to another track. 
When dragging an event from one track to another (up or down), the 
position of the event will be constrained within an automatic snapping 
range to make it easy to keep the event at the same time position. To 
defeat this snapping, hold Shift while dragging the event up or down.

Rearrange Tracks.

To rearrange tracks using the Arrow tool, click on the track you want to move and 
drag up or down in the Tracks list. You will notice a blue line following your mouse. 
When you drop the track, it will be inserted where the blue line is located.
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Size an Event.

Events can be thought of as windows into audio files and musical performances, 
where what you see is what you hear. You can resize events to make them shorter 
or longer so that only a portion of the audio or musical data is seen and heard.

To size any event using the Arrow tool, float the mouse to the left or right edge of the 
event to reveal the Sizing tool. When this tool appears, click-and-drag left or right to 
size the event. Events can be sized and resized nondestructively any number of times.

Select Multiple Events. 

Multiple events can be selected in order to edit them all at once, with a single 
action. To select multiple events with the Arrow tool, do one of the following:

 • Click outside of the range of an event and then drag over any other 
events; a gray box will be drawn while you drag over the target-selection 
area. Release the mouse button once the box is drawn over all of the 
events you wish to edit, and these events will be selected for editing.

 • Click on any event; then, while holding [Shift] on the keyboard, click on any other 
events to select them. This allows you to select multiple events that are not in 
close proximity to each other. All selected events can then be edited at once.

3.3.6.2 Range Tool

The Range tool is used to select a range, or area, within events. Click on the Range 
tool button or press [number 2] on the keyboard to select the Range tool. 

To select a range within an event, using the Range tool, click-and-drag over the area 
to be selected; a gray box will be drawn over the target selection area.  
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Release the mouse button when the box is drawn over the 
range of the events you wish to select. The range you have 
selected is now treated as a single, consolidated event.

The Range tool can be useful in several ways:

 • You can use the Range tool to select the content of several audio events 
across multiple tracks for a specific portion of a song (say, an amazing 
drum groove) and then use the Arrow tool to move that section of 
audio to another section of a song (say, to replace a drum groove).

 • Another common use of the Range tool is to quickly select and delete a 
range of audio within an event, rather than using the Split tool to make 
two splits, then select and delete the section with the Arrow tool.

Power User Tip: When you float the mouse cursor over a selected range, the Arrow tool 
will temporarily appear. This makes it easy to quickly select and edit a range of events.

To select multiple, discontiguous ranges across any event, on any track, hold the 
[Shift] key while using the Range tool. Continue to hold [Shift] and use the Arrow 
tool to select whole events. For instance, when using the Arrow tool, if you press 
and hold [Ctrl], you get the Range tool. Press and hold [Ctrl] and [Shift] to select 
multiple ranges, then continue to hold [Shift] but release [Ctrl]; now you have the 
Arrow tool and can select whole events. All of your selections will remain selected.

Selected ranges can be sized by floating the Range tool at the left/
right edge of the selection. You also can split a selected range at the left 
and right edges of the selection by choosing Split Range from the Edit 
menu or by pressing [Ctrl]/[Cmd]+[Alt]+[X] after selecting a range.

3.3.6.3 Split Tool

Using the Split tool, single events can be split into multiple events. Click on the Split 
Tool button or press [number 3] on the keyboard to select the Split tool.

With the Split tool selected, a vertical and horizontal line will be drawn near the 
current mouse-cursor position. The vertical line indicates the exact time position 
of the Split tool, while the horizontal line underscores the track on which the event 
to be split resides. The Split tool is directly affected by the current Snap settings.

Click on any event with the Split tool to split the event at that position. 
By splitting a single event, you create two events that can be edited 
independently. If multiple events are selected across multiple tracks, 
the Split tool will affect all of the selected events in the same way.

It is also possible to split selected events at the timeline cursor, without 
using the Split tool, by pressing [Alt]+[X] on the keyboard.

3.3.6.4 Eraser Tool

The Eraser tool is used to delete an event. Click on the Eraser Tool button or press 
[number 4] on the keyboard to select the Eraser tool. To delete any event using the 
Eraser tool, simply click on the event. The Eraser tool is unaffected by the current 
selection and will only affect the event that is directly clicked on.

However, if you click on a selected element with the Eraser 
tool, all currently selected elements will be erased.

3.3.6.5 Common Editing Actions

Like most software applications, Capture 2 supports basic cut, 
copy, and paste actions. Once you’ve selected an event, or a range 
of events, you can perform these actions as follows:

 • Cut: Press [Ctrl]/[Cmd]+X on the keyboard to cut 
the current selection or select Edit>Cut.

 • Copy: Press [Ctrl]/[Cmd]+C on the keyboard to copy 
the current selection or select Edit>Copy.
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 • Paste: Once a selection is cut or copied, press [Ctrl]/[Cmd]+V on the keyboard 
to paste the selection or select Edit>Paste. The selection will be pasted to the 
current playback-cursor position, or to the beginning of the track from which 
the selection originated if the playback cursor is not currently set anywhere.

3.3.6.6 Looping

To loop the playback of any range of your Capture 2 Session, do one of the following:

 • Loop Selection. Select an event with the Arrow tool or select a range with 
the Range tool. Go to Session>Loop Selection or press P on your keyboard. 
This will create a loop the exact length of the selected audio event. The range 
will be indicated by a bar drawn in the timeline, with flags at both ends.

 • Custom Loop Range. To create a custom loop range, mouse over 
the gray line above the timeline ruler. Notice that your cursor 
changes to a Pencil tool, and you can draw your loop range.

Once your loop range is set, you can click on the Loop button in the transport, or 
press [L] or [/] on the keyboard, to engage Loop mode.

Please Note: Engaging Record in the transport will disable Loop 
mode and will begin recording at the current playback-cursor 
position. It is not possible to engage Loop while recording.

3.3.6.7 Bounce Selection

Once you have edited an audio file, you may wish to create a new audio file 
that includes all of your edits. To do this, use the Range tool to select the 
events you would like to merge as described in Section 3.3.6.2 and press 
[Ctrl]/[Cmd]+[B] on the keyboard or go to Edit>Bounce Selection.



26

3 Capture 2 
3.3 The Session Page

StudioLive™ AR-Series Software  
Library Reference Manual

3.3.7 Meter Bridge

Capture 2 provides input and output metering 
when a track is being recorded or played back. 
These peak-style meters at the bottom of the 
Session page feature clip indicators for each input 
into Capture 2 from the StudioLive AI mixer. 

Record Arm.

Below each meter, you will find another Record Arm button. This button provides the 
same functionality as the Record Arm button in the Track column. See Section 3.3.1 
for more information.

Link Button.

Between each meter you will find a Link button. When this button is active, Capture 2 
will record that track as a stereo-interleaved file. By default, the mix mix track is stereo 
linked.

Big Meter Mode.

The Big Meter Mode button is located in the upper right 
corner of the Session page, above the editing tools.

When this button is engaged, the lower three-quarters of the Session page 
will display detailed metering for every track. While in this mode, the Marker 
Lane, transport, mode buttons, and editing tools will still be visible.

3.3.8 Markers and the Marker List

The Marker Lane.

The Marker Lane is located just below the Timeline Ruler. 
It displays any markers you have created.

In Capture 2, the Marker Lane is used to place markers at desired 
places in the timeline, after which navigation to the markers is easy. 
Markers are also helpful when exporting your Session to individual 
mixes or for editing in another recording application.

Power User Tip: We highly recommend that markers be inserted during the recording of a 
live performance, as the markers will make the rest of the production process much easier.
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The Marker List.

The Marker List button is located above the editing tools on the right side 
of the Session page. Clicking on the button will open the Marker List, which 
provides an overview of every marker in your Session and offers an easier 
way to quickly name markers and move them around your Session.

3.3.8.1 Inserting, Naming, Deleting, and Moving Markers

Marker Lane.

Adding/Deleting Markers. At the top of the Track column, you will see the Add/
Remove Marker buttons. To insert a new marker into the Marker Lane, with playback 
running or stopped, click on the Add Marker (+) button, or press [Insert] on the 
keyboard. Each new marker will be numbered sequentially by default (#1, #2, #3….).

Select a marker and click on the Remove Marker (-) button to remove the marker.

Naming Markers. To rename a marker, double-click on the marker in the Marker 
Lane, type in a new name, and then press [Enter] on the keyboard. 
 
 
 

Moving Markers. To move a marker, click on it in the 
Marker Lane and drag it to the desired location.

Marker List.

At the bottom of the Marker List, you will find three buttons.

Adding Markers. Click on Add Marker to add a marker 
at the current playback-cursor position. 

When a Marker is added to the Marker List, the Name field 
automatically becomes editable. Enter a new name and hit Enter. 
This name can be edited later by double-clicking on it.

Moving Markers. Clicking on the Move Marker button will move the currently 
selected marker in the Marker List to the current playback position in the timeline.

Deleting Markers. To remove a marker, select it in the 
Marker List and click on the Delete Marker button.
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3.3.8.2 Navigating Markers

It is possible to quickly jump the playback cursor between markers in 
the Marker Lane. Jumping to markers during playback allows quick 
comparisons between different sections of your Session.

To navigate to a previous marker, do one of the following:

 • Click on the Previous Marker button in the transport.

 • Press [B] on the keyboard, to jump to the previous marker.

To navigate to the next marker, do one of the following:

 • Click on the Next Marker button in the transport.

 • Press [N] on the keyboard, to jump to the next marker.

To jump to any marker in your Session, open the Marker List and click on the 
Location field. The playback cursor will jump to this location in the timeline.

3.4 Recording a Session in Capture

Setting Input Levels. Setting the proper input level is critical to making a good 
live mix and a good recording. The basic idea is to set the input gain on the 
StudioLive AI mixer as high as possible without overloading the input. Overloading 
the input will cause clipping (digital distortion), which is particularly unpleasant 
and will ruin the recording. This damage cannot be undone in software. There 
is a clip indicator for each input on the StudioLive AR mixer for this purpose.

If an input channel is not clipping on your StudioLive AI mixer, you 
can be sure that it will not clip in Capture 2. Refer to your StudioLive 
Hardware Owner’s Manual for the proper level-setting procedure.

You will monitor live audio input on the StudioLive AI mixer; there is no separate 
monitoring capability within Capture 2. Please refer to the StudioLive Hardware 
Owner’s Manual for information on creating monitor mixes.

Arming Tracks. To record to an audio track, the track must be record-
enabled, or “armed.” Capture 2 provides two Record Enable buttons for 
each input: one on the track and on the meter bridge. Once an audio 
track is record enabled, you are ready to record audio to that track.

Hit Record! To activate recording, click on the Record button in the transport. The 
Record button will turn red, and the Play button will turn green. The playback cursor 
will start to scroll from left to right from its current position, and new audio events 
will be recorded to record-enabled tracks.

Recording will continue until you manually stop it by clicking on the Stop button in 
the Transport or by pressing [Spacebar] on the keyboard. 

When you press Record, the Session automatically locks. This prevents you from 
accidentally stopping recording Session. You must disable Session Lock before you 
can stop recording.
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3.5 Importing and Exporting Audio Files

3.5.1 Importing Audio Files into Capture

It is possible to import WAV and AIFF audio files into your Session.

1. To import an audio file, select Import Audio File from the Session menu, 
or [Ctrl]/[Cmd]+I on the keyboard, to open the Import File menu.

2. Browse to the desired file and click on it to select it.

3. Click on Open to import the file into your Session.

4. An audio event for the imported file will be created and placed on the currently 
selected track in your Session, at the current playback-cursor position.

Power User Tip: When browsing for files in the Import File menu, it is possible to listen 
to the audio files as you are browsing in the Preview Player. Click the Play button in the 
Preview Player to play the currently selected audio file. Click the Stop button to stop 
playback. Click the Loop button to loop the playback of the currently selected audio file.
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3.5.2 Export Audio Files

To export audio from your Session in Capture 2, navigate to Session/Export Tracks, 
or press [Ctrl]/[Cmd]+E on the keyboard to open the Export to Tracks menu.

Location.

In the top section of the Export Tracks menu, select 
a location and name for the audio file.

Click on the Browse button to choose a file location.

Double-click on the filename, type in a new name, and then press Enter to 
choose a name for the file. Each file that is exported will begin with the filename 
you enter, followed by the name of the track from which it was exported 
and the first marker of the marker pair (if applicable). Examples: “French 
Quarter Fest 2012 – Kick” or “French Quarter Fest 2012 – Kick – Chorus.”

Format.

In the middle section of the Export Tracks menu, select the 
format of the mixdown audio file. Choose from WAV or AIFF, and 
then choose the desired resolution and sample rate.

If you wish to put your audio on a standard audio CD, the format should 
be a WAV file with 16-bit resolution and a 44.1 kHz sample rate.
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Options.

The bottom section of the Export Tracks menu has several 
options that will affect how files are created:

 • Export Session will export the entire range of your Session to the 
furthest point in time that any audio event on a track extends.

 • Export Between Each Marker will export separate files for 
each range between the markers in the Marker Lane.

 • Export Between Selected Markers will export audio files between 
the ranges of any two selected markers in the Marker Lane.

3.6 Mixing Your Capture Sessions

3.6.1 Exporting Your Final Mix to an Audio File

The most common physical medium on which recordings are published 
is the audio CD. In order to put your final mix on an audio CD, the mix file 
must be a 16-bit, 44.1 kHz WAV file. Once you have recorded your final mix 
to the Auxiliary Stereo track in Capture 2, it is recommended you export 
the audio from the Auxiliary Stereo track to an audio file for this purpose. 
See Section 6.6.2 for details on Exporting Audio Tracks in Capture 2.

Once the correct audio file for your mix has been exported, you 
may use any CD-burning application (including PreSonus Studio 
One Professional) to put that mix on a recordable audio CD.

3.6.2 Mixing a Capture 2 Session in Studio One

Many users want to use Capture 2 strictly as a track-recording tool and will 
mix and sweeten the recorded tracks later in a DAW. PreSonus has included a 
copy of Studio One Artist with your StudioLive for this purpose. All versions of 
Studio One can open Capture 2 Session files. All markers, edits, track names, 
etc., will be preserved, and no further effort is required. Simply launch Studio 
One and open your Capture 2 Session. See Section 7 for more details.

3.6.3 Mixing a Capture 2 Session in a Different Recording Application

For users who wish to mix their Capture 2 Session in a DAW other than Studio 
One, there are several ways in which to import your Capture 2 Session.

Save a Capture 2 Session as OpenTL

Many audio-recording programs can open OpenTL (Open Track List) files. An OpenTL 
file provides a reference for all of the audio tracks and audio events, with their 
corresponding positions, in a Capture 2 Session, so that another audio program can 
reconstruct your Session automatically. This makes it possible for you to open your 
Capture 2 Session and work as you normally do in your favorite recording application.

To save an OpenTL version of your Session, select Save 
Session As in the File menu of Capture 2.
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Name the file as usual, and choose OpenTL (*.tl) in the Save As Type selection box.

Click on Save to save your Session as an OpenTL document and confirm the 
command by clicking Yes in the confirmation window. This file will be placed 
by default in your Session folder and will not overwrite the original Capture 2 
Session file. Note that the OpenTL format will not save your markers.

Import Capture 2 Session Audio Files Directly

Some audio-editing applications (such as digital audio workstations, or DAWs) 
do not support the OpenTL format, which makes the options somewhat limited 
when importing Sessions created in other programs. In this case, you must 
manually import the audio events from your Capture 2 Session into the audio-
editing application, using whatever means possible in that program. Refer to 
the documentation of your software for more information on this process.

Note that in some cases, you may have more than one audio event on a given track, 
as opposed to a single continuous audio event, or you may have audio events that 
do not have the same start position. In either case, it is highly recommended that 
you first export the audio for each track before attempting to import into an audio-
editing program, as described in the Export Audio Files portion of this section.

Be sure to select the Export Tracks option in the Export Audio 
File menu, as shown, so that the result of the process will be a 
single continuous audio file for each track in the Session.

Once you have single, continuous audio files for each track, directly importing 
the files into an audio editor is much easier. All that is required to reconstruct 
your Capture 2 Session is to align each file at the same start time. For complete 
information on exporting tracks from Capture 2, please review Section 3.6.2.
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3.7 Capture 2 Key Commands

Action Key Command

File Menu

New Session Cntrl/Cmd+N

Open Session Cntrl/Cmd+O

Close Session Cntrl/Cmd+W

Save Session Cntrl/Cmd+S

Save Session As Cntrl/Cmd+Shift+S

Quit Cntrl/Cmd+Q

Edit Menu

Undo Cntrl/Cmd+Z

Redo Cntrl/Cmd+Y

Cut Cntrl/Cmd+X

Copy Cntrl/Cmd+C

Paste Cntrl/Cmd+V

Delete Del

Select All Cntrl/Cmd+A

Deselect All Cntrl/Cmd+D

Bounce Selection Cntrl/Cmd+B

Zoom In Cntrl/Cmd + or E

Zoom Out Cntrl/Cmd - or W

Zoom Full F

Session Menu

Import File Command+I

Export Tracks Command+E

Toggle Start/Stop Space Bar

Record NumPad *

Stop 0

Return to Zero ,

Go to End E

Loop Active /

Loop Selection P

Locate Selection L

Insert Marker Ins, I

Insert Named Marker Shift+Ins, Shift+I

Locate Next Marker N

Locate Previous Marker B

Enable Sound Check F4

Tools

Select Arrow Tool 1

Select Range Tool 2

Select Split Tool 3

Select Eraser Tool 4

Views

Options Cntrl/Cmd+[+]

Big Meters F2

Marker List F3

Enable Soundcheck F4

Action Key Command

Transport

Toggle Start/Stop Space Bar

Start Enter

Record NumPad *

Stop NumPad 0

Return to Zero NumPad

Record Lock Cntrl/Cmd+L

Navigation

Focus Next Tab

Focus Previous Shift+Tab

Left Left Arrow

Extend Selection Left Shift+Left Arrow

Extend Selection Left Add Cntrl/Cmd+Shift+Left Arrow

Skip Left Cntrl/Cmd+Left Arrow

Right Right Arrow

Extend Selection Right Shift+Right Arrow

Extend Selection Right Add Cntrl/Cmd+Shift+Right Arrow

Skip Right Cntrl/Cmd+Right Arrow

Up Up Arrow

Extend Selection Up Shift+Up Arrow

Extend Selection Up Add Cntrl/Cmd+Shift+Up Arrow

Skip Up Cntrl/Cmd+Up Arrow

Down Down Arrow

Extend Selection Down Shift+Down Arrow

Extend Selection Down Add Cntrl/Cmd+Shift+Down Arrow

Skip Down Cntrl/Cmd+Down Arrow

Page Up Page Up

Extend Selection Page Up Shift+Page Up

Extend Selection Page Up 
Add
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4 Studio One Artist Quick Start

All PreSonus professional recording products come with Studio One Artist 
recording and production software. Whether you are about to record 
your first album or your fiftieth, Studio One Artist provides you with all 
of the tools necessary to capture and mix a great performance. 

Power User Tip: As a valued PreSonus customer, you are eligible for a discount 
upgrade to Studio One Professional. For more details on the Studio One upgrade 
program for PreSonus customers, please visit http://studioone.presonus.com/.

4.1 Installation and Authorization

Once you have installed the drivers for your audio interface and connected it 
to your computer, you can use the included PreSonus Studio One Artist music-
production software to begin recording, mixing, and producing your music. 
To install Studio One Artist, log into your My PreSonus account and register 
your interface. Your product key for Studio One Artist will automatically be 
registered to your My PreSonus account with your hardware registration.

Downloading and running the Studio One installer.

To install Studio One Artist, download the Studio One Artist installer from 
your My PreSonus account to the computer on which you will use it.

http://studioone.presonus.com/
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 • Windows users: Launch the Studio One Artist installer 
and follow the onscreen instructions.

 • Mac users: Drag the Studio One Artist application into 
the Applications folder on your Mac hard drive.

Authorizing Studio One

When Studio One is launched for the first time on your computer, it will 
communicate with your My PreSonus account and verify your registration. To 
ensure a seamless authorization process, make sure to download your installer 
to the computer on which you will be using it and be sure that your computer is 
connected to the Internet when you launch the application for the first time.

Installing bundled content for Studio One Artist.

Studio One Artist comes bundled with an array of demo and tutorial 
materials, instruments, loops, and samples. The Studio One Artist 
bundle includes all that you need to begin producing music.

The first time you launch Studio One Artist, you will be prompted 
to install its companion content. Select the content you wish to 
add and click “Install.” The content will automatically begin to 
download and install from your My PreSonus user account. 

Power User Tip: You may be prompted to enter your My PreSonus user account 
information. Clicking “Remember Credentials” will allow you to have immediate 
access to any content you purchase from the PreSonus Marketplace. 

4.2 Setting Up Studio One

Studio One Artist was designed to work with PreSonus interfaces and provides 
unique interoperability and simplified setup. When Studio One Artist is 
launched, by default you will be taken to the Start page. On this page, you will 
find document-management and device-configuration controls, as well as a 
customizable artist profile, a news feed, and links to demos and tutorials from 
PreSonus. If you have an Internet connection on your computer, these links will 
be updated as new tutorials become available on the PreSonus Web site.

Complete information on all aspects of Studio One Artist is available in 
the Reference Manual PDF located within Studio One. The information 
in this tutorial covers only the basic aspects of Studio One Artist and is 
intended to get you set up and recording as quickly as possible.



36

4 Studio One Artist Quick Start 
4.2 Setting Up Studio One

StudioLive™ AR-Series Software  
Library Reference Manual

4.2.1 Configuring Audio Devices

1. In the middle of the Start page, you will see the Setup area. Studio One 
Artist automatically scans your system for all available drivers and selects 
a driver. By default, it will choose a PreSonus driver if one is available. 

2. If you do not see your device listed on the Start page when 
you launch Studio One, click on the Configure Audio Devices 
link in the Setup area to open the Options window. 

In the Options window, click on the Audio Setup tab and 
select your device driver from the pull-down.
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4.2.2 Configuring MIDI Devices

From the External Devices window in Studio One Artist, you can configure 
your MIDI keyboard controller, sound modules, and control surfaces. This 
section will guide you through setting up your MIDI keyboard controller 
and sound modules. Please consult the Reference Manual located within 
Studio One for complete setup instructions for other MIDI devices.

If you are using a third-party MIDI interface or USB MIDI-controller 
keyboard, you must install any required drivers for these devices before 
beginning this section. Please consult the documentation that came 
with your MIDI hardware for complete installation instructions.

If you do not have any MIDI devices, please skip to Section 5.4.

Setting up an external MIDI keyboard controller from the Start page.

A MIDI keyboard controller is a hardware device that is generally used for playing 
and controlling other MIDI devices, virtual instruments, and software parameters. 
In Studio One Artist, these devices are referred to as Keyboards, and they must be 
configured before they are available for use. In some cases, your MIDI keyboard 
controller is also used as a tone generator. Studio One Artist views the controller 
and tone-generation functions as two different devices; a MIDI keyboard controller 
and a sound module. The MIDI controls (keyboard, knobs, faders, etc.) will be 
set up as a Keyboard. The sound modules will be set up as an Instrument.

You can set up your external MIDI devices from the Setup area 
in the Start page. Before setting up a new Song for recording, 
take a moment to configure external devices.

Make sure you have connected the MIDI Out of your external MIDI controller to 
a MIDI In on your PreSonus audio interface (if available) or other MIDI interface. If 
you are using a USB MIDI controller, connect it to your computer and power it on.

1. Click on the Configure External Devices link in the Setup area on 
the Start page to launch the External Devices window.
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2. Click the Add button. This will launch the Add Device window.

3. From the menu on the left, select your MIDI controller from the list of 
manufacturers and models. If you do not see your MIDI controller listed, 
select New Keyboard. At this point, you can customize the name of 
your keyboard by entering the manufacturer and device names.

4. You must specify which MIDI channels will be used to communicate with 
this keyboard. For most purposes, you should select all MIDI channels. 
If you are unsure of which MIDI channels to choose, select all 16.

5. Studio One allows you to filter out specific control functions. If you would 
like Studio One to ignore Aftertouch, Pitch Bend, Program Change, or 
All CC messages, enable filtering for any or all of these messages.

6. In the Receive From drop-down menu, select the MIDI interface 
input from which Studio One Artist will receive MIDI data (that 
is, the MIDI port to which your keyboard is connected).

Power User Tip: In the Send To drop-down menu, select the MIDI 
interface output from which your Studio One Artist will send MIDI data 
to your keyboard. If your keyboard controller doesn’t need to receive 
MIDI data from Studio One, you can leave this unselected.
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7. If this is the only keyboard that you will use to control your external 
synthesizers and virtual instruments, you should check the box 
next to Default Instrument Input. This will automatically assign your 
keyboard to control all MIDI devices in Studio One Artist.

8. Click OK.

If you have a sound module that you’d like to connect, leave the External 
Devices window open and proceed to the next part of this section. 
If not, you can close the window and skip to the next section.

Setting up an external MIDI sound module from the Start page.

MIDI instrument controllers (keyboards, MIDI guitars, etc.) send musical information 
in the form of MIDI data to tone modules and virtual instruments, which respond 
by generating sound, as instructed. Tone modules can be standalone sound devices 
or can be integrated into a MIDI instrument, such as a keyboard synthesizer. Studio 
One Artist refers to all tone generators as Instruments. Once you have set up your 
MIDI keyboard controller, take a moment to configure your sound module.

Make sure you have connected the MIDI In of your external 
sound module to the MIDI Out of your MIDI interface.

1. In the External Devices window, click the Add button.
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2. Select your device in the menu on the left. If your device is not listed, 
select New Instrument. At this point you can customize the name of 
your keyboard by entering the manufacturer and device names.

3. Specify which MIDI channels will be used to communicate with this sound 
module. For most purposes, you should select all MIDI channels. If you are 
unsure of which MIDI channels to select, we suggest you select all 16.

4. In the Send To menu, select the MIDI interface output from which Studio One 
Artist will send MIDI data to your sound module. Click OK and close the External 
Devices window. You are now ready to start recording in Studio One Artist. 

The rest of this Quick Start Guide will go over how to set 
up a Song and will discuss some general workflow tips for 
navigating through the Studio One Artist environment.

4.3 Creating a New Song

Now that you’ve configured your audio and MIDI devices, let’s create 
a new Song. We’ll start by setting up your default audio I/O.

1. From the Start page, select Create a New Song.
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2. In the New Song window, name your Song and choose the directory in which 
you’d like it saved. From the Interfaces tab, you can select custom templates for 
your StudioLive AR-series mixer that will set all configuration and I/O settings for 
you. The rest of section will describe creating a Song from an empty session.

3. Select Empty Song from the Templates list. At this point, you should give 
your Song a name and select your preferred sample rate and bit depth for 
recording and playback. You can also set the length of your Song and the 
type of time format you would like the timeline to follow (notation bars, 
seconds, samples, or frames). Click the OK button when you are finished.

Power User Tip: If you plan to import loops into your Song, make 
sure that the Stretch Audio Files to Song Tempo option is selected. 
This will automatically import loops at the correct BPM.

4.3.1 Configuring Your I/O

1. Click on Song | Song Setup to set your sample rate and 
resolution and configure your audio I/O.

2. Click on the Audio I/O Setup tab.
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3. From the Inputs tab, you can enable any or all of the inputs on your StudioLive 
AR mixer that you’d like to have available. We recommend that you create a mono 
input for each of the inputs on your interface. If you plan on recording in stereo, 
you should also create a few stereo inputs. You can give each input a custom name 
by simply clicking on the default name. Press the TAB key to edit the next name.

4. Click on the Outputs tabs to enable any or all of the outputs on your StudioLive 
AR Mixer. In the lower right corner, you will see the Audition select menu. This 
allows you to choose the output from which you will audition audio files prior 
to importing them into Studio One Artist. In general, you will want this to 
be the main output bus. You can give each output a custom name by simply 
clicking on the default name. Press the TAB key to edit the next name.

Power User Tip: If you would like this I/O configuration to be the same 
every time you open Studio One, click the Make Default button.
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4.3.2 Creating Audio and MIDI Tracks

1. In the upper left corner of the Arrange window, you will notice 
several buttons. The button furthest to the right is the Add Tracks 
button. Click on this button to open the Add Tracks window.

2. In the Add Tracks window, you can customize the track name and 
color, add a preset rack of effects, and set the physical source for 
the input and output of your audio tracks. Most important, you can 
select the number and type of tracks you’d like to create.

 • Audio. Use this track type to record and playback audio files.

 • Instrument. Use this track to record and playback MIDI data to 
control external MIDI devices or Virtual Instrument plug-ins.

 • Automation. This track type lets you create automated 
parameter controls for your session.

 • Folder. This track helps you to manage your session as 
well as to quickly edit multiple tracks at once.

Power User Tip: If you would like to add an audio track for each of the 
available inputs, simply go to Track | Add Tracks for All Inputs.

Mute

Custom
Track
Color

ST/Mono

Audio Input
Source Select

Solo

Rec
Arm

Monitor

Track
Name

Meter

Note: MIDI tracks are nearly identical to Audio tracks. The Input 
Source list for MIDI tracks lists available external MIDI devices as well 
as any virtual instruments that have been added to the Song.
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4.3.3 Recording an Audio Track

1. To begin recording, create an audio track from the Add Tracks 
window, set its input to Input 1 on your StudioLive AR-series 
mixer, and connect a microphone to the same input.

2. Select Record Enable on the track. Turn up the Input 1 level on your audio 
interface while speaking/singing into the microphone. You should see 
the input meter in Studio One Artist react to the input. Adjust the gain 
so the input level is near its maximum without clipping (distorting).

You are now ready to start recording. For complete instructions, please consult the 
Studio One Reference manual located in Help | Studio One Reference Manual.

4.3.4  Adding Virtual Instruments and Effects

You can add plug-ins and instruments to your Song by dragging-and-dropping 
them from the browser. You can also drag an effect or group of effects from one 
channel to another, drag in customized effects chains, and instantly load your 
favorite virtual-instrument preset without ever scrolling through a menu.

Opening the browser.

In the lower right corner of the Arrange window are three buttons:

 • The Edit button opens and closes the audio and MIDI editors.

 • The Mix button opens and closes the Mixer window.

 • The Browse button opens the browser, which displays all of the 
available virtual instruments, plug-in effects, audio files, and MIDI files, 
as well as the pool of audio files loaded into the current session.
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Drag-and-drop virtual instruments.

To add a virtual instrument to you session, open the browser and click on 
the Instrument button. Select the instrument or one of its patches from the 
instrument browser and drag it into the Arrange view. Studio One Artist will 
automatically create a new track and load the instrument as the input.

Drag-and-drop effects.

To add a plug-in effect to a track, click the Effects button in the browser and 
select the plug-in or one of its presets in the effects browser. Drag-and-drop 
the selection over the track to which you would like to add the effect.



Drag-and-drop audio and MIDI files.

Audio and MIDI files can be quickly located, auditioned, and imported into 
your Song by dragging them from the file browser into the Arrange view. 
If you drag the file to an empty space, a new track will be created with 
that file placed at the position to which you dragged it. If you drag the file 
to an existing track, the file will be placed as a new part of the track.
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 Dinner is Served

Added bonus: PreSonus’ previously Top Secret recipe for…

Redfish Couvillion
Ingredients:
 • ¼ C Vegetable oil

 • ¼ C flour

 • 1 onion diced

 • 1 clove garlic minced

 • 1 green pepper diced

 • 3 celery stalks diced

 • 1 14oz can diced tomatoes

 • 1 bottle light beer 

 • 2 bay leaves

 • 1 tsp thyme

 • 2 lbs Redfish fillets

Cooking Instructions:
1. In a heavy saucepan or large skillet, heat oil on medium high and slowly add flour a tablespoon at a time to create a roux. 

Continue cooking the roux until it begins to brown, creating a dark blond roux. 

2. Add garlic, onions, green pepper, and celery to roux.

3. Sauté vegetables for 3-5 minutes until they start to soften.

4. Add tomatoes, bay leaves, thyme, and redfish. Cook for several minutes.

5. Slowly add beer and bring to a low boil.

6. Reduce heat and simmer uncovered for 30-45 minutes until redfish and vegetables are completely cooked, stirring 
occasionally. Break up redfish into bite size chunks and stir in. Add pepper or hot sauce to taste. Do not cover.

7. Serve over rice

Serves 6-8

While not one of Southeast Louisiana’s more famous dishes, Redfish Couvillion is a favorite way to serve our 
favorite Gulf fish. Also known as Reds or Red Drum, Redfish is not only fun to catch, it’s also delicious!
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